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Old photographs are fascinating on several levels.  For some the age of the photo and the extent to 

ǿƘƛŎƘ ƛǘ ƛǎ άŘƛǎǘǊŜǎǎŜŘέ ς faded, stained, scratched, and otherwise physically damaged ς become a major 

part of what they like.  Artists will often take a modern photo and intentionally damage it to give it that 

άƻƭŘ ǇƘƻǘƻέ ƭƻƻƪΦ  L Řƻ ǘƘŜ ƻǇǇƻǎƛǘŜΦ 

CƻǊ ǘƘŜ 9ƭǾŜǊƘƻƧ aǳǎŜǳƳΩǎ1 photo history project, the most interesting part of the old photos is what 

they show.  They are images from the past; the closest we can come to time traveling back to a previous 

era.   So, not unlike my contemporary black and white landscape photos, where I try to give people a 

ǿƛƴŘƻǿ ƛƴǘƻ ŀ .ϧ² ǊŜŀƭƛǘȅΣ LΩǾŜ ǘǊƛŜŘ ǘƻ ƳŀƪŜ ǘƘŜǎŜ ǊŜǎǘƻǊŀǘƛƻƴǎ ǿƛƴŘƻǿǎ ƛƴǘƻ {ƻƭǾŀƴƎΩǎ ǇŀǎǘΦ  We want 

these windows to the past as clear as possible, and we want them to stay that way for many years. 

 

                                                             
1 See http://www.elverhoj.org/   

http://www.elverhoj.org/
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A. Scanning  

The process of digital photo restoration and preservation starts with a scan of the old photograph.2  

Ideally, we would like to start with a pristine negative and scan it at a high enough resolution to capture 

all the image information that it contains.  However, in the real world, those original negatives are rarely 

available.  The best images we started with in the Elverhoj photo restoration project appeared to be 

contact prints of 5 by 7 inch negatives.  A good contact print, where the negative is pressed against 

printing paper and not enlarged, has the advantage that there was only a single (and very old) lens 

between the original scene and the print we were able to scan.   At the other end of the spectrum, some 

of the source materials we had to work with were poor scans of prints that were probably made with an 

enlarger that was out of alignment and used a poor lens.  But, even there, the image content may be so 

compelling that, with the defects minimized, the image softness by itself does not seriously alter or 

distract from the feeling conveyed by the final reproduction.  

Many scanners have some image editing options available in the scanner software.  Most of these 

editing options are best left to Photoshop3 after the scan is completed.  With the scan the goal is simply 

to capture as much information from the photo as possible. 

¢ƘŜ ǎŜǘǘƛƴƎǎ ōŜƭƻǿ Ƴŀȅ ōŜ ƛƴ ŀƴ ά!ŘǾŀƴŎŜŘέ ƳŜƴǳΦ  ¢ȅǇƛŎŀƭƭȅ ǎŎŀƴƴŜǊǎ ŀƴŘ ǇǊƛƴǘŜǊǎ ƘŀǾŜ ŀƴ ƛƴƛǘƛŀƭ ƳŜƴǳ 

that is very simplified.  

 1. Resolution  

Among the variables on most scanners is the resolution for scanning the original.  Most scanners can go 

beyond what is really needed, and large files are difficult to work with and store.  So, what is really 

needed? 

  a. Film ς use the top optical resolution  

²ƘƛƭŜ LΩƳ ƴƻǘ ƛƴŎƭƛƴŜŘ ǘƻ ǿŀƴǘ ǘƻ ƻǾŜǊŘƻ ǘƘŜ ǊŜǎƻƭǳǘƛƻƴΣ ŦƛƭƳǎ Ŏŀƴ ƘƻƭŘ ǾŜǊȅ ƘƛƎƘ ǊŜǎƻƭǳǘƛƻƴǎΦ  ²ƛǘƘ Ƴȅ 

4000 dpi4 Nikon film scanner, I almost always scan at the top optical resolutionΣ ŀƴŘ LΩƳ ǎǘƛƭƭ ƭƻǎƛƴƎ 

information relative to what is on the film.  Flatbed scanners are generally not nearly as sharp as 

dedicated film scanners at the same alleged dpi.  {ƻΣ ǳǎŜ ǘƘŜ ǎŎŀƴƴŜǊΩǎ Ŧǳƭƭ ƻǇǘƛŎŀƭ resolution for films, 

but do not άƛƴǘŜǊǇƻƭŀǘŜΦέ  ¢Ƙŀǘ Ŏŀƴ ōŜ ŘƻƴŜ ƭŀǘŜǊ ŀƴŘ ōŜǘǘŜǊ ƛŦ ƳƻǊŜ ǇƛȄŜƭǎ ŀǊŜ ƴŜŜŘŜŘΦ  Yƴƻǿ ǿƘŀǘ ȅƻǳǊ 

ǎŎŀƴƴŜǊΩǎ ǘƻǇ άƻǇǘƛŎŀƭέ όǘǊǳŜΣ ǳƴ-interpolated) resolution is and use it for films.  If the resolution turns 

out to be higher than needed, image size can also be reduced in Photoshop, while also checking to see 

that no image detail is being eliminated. 

 

                                                             
2 Note that preserving the originals is also important.  I make a few suggestions in that regard later, but the details 
of that field are beyond this project. 
3 Adobe Photoshop is the industry standard image editing software.  Competing products can be very good also.  I 
usually recommend Photoshop Elements for those who want to avoid the cost of the full program.  Elements has 
most of the important tools contained in the more expensive program. 
4 ά5ƻǘ ǇŜǊ ƛƴŎƘέ ς ƳƻǊŜ ŀŎŎǳǊŀǘŜƭȅ άǇǇƛέ ƻǊ ǇƛȄŜƭ ǇŜǊ ƛƴŎƘΣ ōǳǘ Ƴƻǎǘ ǳǎŜ ǘƘŜ άŘǇƛέ abbreviation for both. 
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  b. Paper Prints  

¢ƘŜ ŜƴƭŀǊƎƛƴƎ ǇŀǇŜǊ LΩǾŜ ǘŜǎǘŜŘ Ŏŀƴ ƘƻƭŘ ŀǘ Ƴƻǎǘ ŀōƻǳǘ 25 line pairs/mm.  To capture this amount of 

information a scanner resolution of at least a theoretical 1250 dpi is needed ς 1600 is probably a good 

setting for the very best prints.  In reality, however, LΩǾŜ ŦƻǳƴŘ ǘƘŀǘ 600 dpi usually captures all the 

information that is contained in most old photos. 

  c. Work back from print size  

If you know what the final print size is going to be, another approach is to simply work back from the 

print size.  There is little reason to have a file that is larger than is needed to make a good print.   

Epson printers have a native resolution 720 dpi, but 360 dpi is the effective limit of what most people 

can see in a normal print.  L ǳǎǳŀƭƭȅ ŘƻƴΩǘ ōƻǘƘŜr with files over 360 dpi at display print size, but I do use 

the full 720 dpi for small, glossy prints of high quality images. 

 2. Histogram/Levels 

hƴŜ ƻŦ ǘƘŜ ŎƻƴǘǊƻƭǎ ƛƴ ǘƘŜ ǎŎŀƴƴŜǊ ǇǊŜǾƛŜǿ ƛǎ ǘƘŜ άƘƛǎǘƻƎǊŀƳέ ǘƻƻƭΦ  .ȅ ǳǎƛƴƎ ǘƘƛǎ tool the white and 

black points of the scanner range are set to the range of densities that is present in the image to be 

scanned.  This setting and the scan that results will have the effect of increasing the contrast of a faded 

photo.  Of course, it also increases the contrast of the dirt and defects in the image, but that will be 

dealt with later.  The scanner auto-exposure settings often do a very good job if the image is properly 

selected in the preview, but be sure by checking the histogram.  

 

After the histogram is set, a faded image already looks noticeably better. 
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Leave a little space above the apparent highlights for spectral highlights that might be too small to see 

on the scanner preview. 

If the image is a color image the scanner may allow each color to be set independently.  This can offset 

the differential fading of the color layers and restore not only contrast but correct color rendition.  If the 

scanner does not have this ability, Photoshop does, and a 16 bit/channel bit depth will give enough 

information to do this without visible steps in the gradient. 

 3. 16 Bit Depth  

Most scanners today allow one to set the bit depth up from the standard 8 bits per channel (256 levels 

of gray) to 16 bits (over 30,000 gray levels).   

 4. Color v. Grayscale 

Unless the image is stained, scanning a black and white photograph in color/RGB5 mode usually 

accomplishes nothing but increasing the file size.  (Prior to scanner support of 16 bit depth, RGB was 

sometimes used as a substitute way to capture more gray levels.)  

Today, the main reason to scan a B&W photo in RGB mode is to remove stains.  These are often a 

different color than the rest of the image.  This color differential can be useful in removing the stain.  

One of the RGB channels may not show the stain at all or barely, and the color of the stain can also be 

used to select that area by color range, which can then be treated separately. 

 5. Save as Tiff file  

Tiff file types are the most widely supported and do not compress the image.  A file format like Jpeg 

compresses the file and will cause image information to be lost. 

B. Image Editing-Retouching  

Once the image is in a digital form, the work of restoration, for me, is mostly aimed at maximizing the 

extent to which viewers can see and appreciate the original image information.  This requires minimizing 

the distractions caused by the damage to the old print.   One might compare the process to washing a 

very dirty window so that viewers can see more clearly what is on the other side.  If the process is 

compared to music restoration, the job might be characterized as maximizing the signal-to-noise ratio. 

Most of the images in this show have been enlarged considerably.  Many of the original prints were, for 

example, postcard-sized.  While some of the old prints looked quite nice when small, upon enlargement 

the defects in the old prints become much more noticeable and distracting.  Typically old emulsions 

have micro-cracking and other surface defects that may have been too small to be visible before 

                                                             
5 tƘƻǘƻƎǊŀǇƘŜǊǎ ƎŜƴŜǊŀƭƭȅ ǿƻǊƪ ƛƴ ǘƘŜ άwŜŘΣ DǊŜŜƴΣ .ƭǳŜέ ǇǊƛƳŀǊȅ ŎƻƭƻǊ ǎǇŀŎŜΦ  hƴ ǘƘŜ ƻǘƘŜǊ ƘŀƴŘ ǘƘŜ ǇǊƛƴǘŜǊǎ ǳǎŜ 
CMYK ς cyan, magenta, yellow and black ink, the complements of RGB. 
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enlargement.  However, these very numerous small scale defects become obvious when enlarged and 

distract us from the lens-formed image information.   Reducing the dƛǎǘǊŀŎǘƛƴƎ άƴƻƛǎŜέ ǿƘƛƭŜ ǎǘƛƭƭ 

showing an appropriate natural image structure and texture ς film grain and paper base ς is part of the 

job. 

This image texture is sometimes helpful.  The very old images were taken with orthochromatic film.  This 

type of black and white film, which was all that was available in the early years of photography, was 

sensitive to blue and green light only.  It pre-ŘŀǘŜŘ ǘƘŜ άǇŀƴŎƘǊƻƳŀǘƛŎέ B&W film we used in the latter 

part of the 20th century.  With the older films the skies were very often totally overexposed and άōƭƻǿƴ 

out.έ  In these cases, the texture of the old paper can provide a pleasing rendering of what is, on the 

film, a totally blank white sky. 

tƘƻǘƻǎƘƻǇ ƛǎ ǘƘŜ ǇǊƛƳŀǊȅ ƛƳŀƎŜ ŜŘƛǘƛƴƎ ǎƻŦǘǿŀǊŜ όάǘƻƻƭ ōƻȄέύ ǘƘŀǘ L ǳǎŜ ǘƻ retouch and otherwise clean 

up the images.  While it has some powerful tools in it, there ƛǎ ƴƻ ǎƛƳǇƭŜ άǇƘƻǘƻ ǊŜǎǘƻǊŀǘƛƻƴέ button one 

can push.  Most of the restoration work is a modern form of manually retouching the image.   The 

tƘƻǘƻǎƘƻǇ άŦƛƭǘŜǊǎέ ǘƘŀǘ remove small spots and scratches cannot distinguish the valid image 

information from the distracting noise.  So, they have to be used very sparingly and applied selectively.   

Some of the primary tools and methods I use are outlined below. 

 1. Straighten the Horizon and Do an Initial Cropping of the Image  

Often images are rotated such that, for example, the horizon in the photo is not level or vertical lines 

slant.  There are at least 2 methods of correcting this problem. 

  a. Ruler - Straighten Method  

With Photoshop CS5 a quick method of leveling an image was added to Photoshop.   This approach is 

particularly quick and easy if there is an obvious horizon line or vertical edge in the image that you can 

use as a guide.  Usually in the old photos I was working with in the Elverhoj project there were no such 

obvious lines; so IΩll use a seascape shot as an example.  The steps are as follows: 

At the left Photoshop tool box, right click on the Eyedropper tool to reveal the options, which include 

the Ruler tool.  Select this one. 
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Place the ruler cross-mark on the horizon (or vertical) reference, hold down the mouse button, and draw 

a line along the reference edge.  

 

After the line is drawn with the Ruler tool, press the άStraightenέ button at the top of the Photoshop 

screen. 

 

Photoshop will straighten the horizon (or vertical line) and crop the image appropriately.   

 

Note that this tool is not available on versions of Photoshop earlier than CS5.  For earlier versions, the 

Image Rotation method, below, must be used. 

  b. Image Rotation Method  

This is the traditional method to get the horizon straight (Image>Image Rotation>Arbitrary).  The 

amount of rotation needed ƛǎ ǘǊƛŀƭ ŀƴŘ ŜǊǊƻǊΦ  ¢Ǌȅ ƻƴŜ ǎŜǘǘƛƴƎ ŀƴŘ ƛŦ ƛǘ ƛǎ ƴƻǘ ǊƛƎƘǘΣ άǳƴŘƻέ ό9ŘƛǘҔ{ǘŜǇ 

back) the rotation and try again.  See the screen grab below. 
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  c. Initial Image Crop   

After getting the image rotation correct, an initial crop of the image is a good idea.  Use the 

άwŜŎǘŀƴƎǳƭŀǊ aŀǊǉǳŜŜ ¢ƻƻƭέΣ ŘǊŀƎƎƛƴƎ ƛǘ ŀŎǊƻǎǎ ǘƘŜ ƛƳŀƎŜ to select the image area you want to keep.  If 

a specific proportion is wanted, this can be set by selecting a άCƛȄŜŘ wŀǘƛƻέ for the selection tool.  Once 

the image area is selected, crop the image (Image>Crop). 

I usually will not crop the image again unless it needs to be sized for a print.  The reason not to touch the 

size, rotation, or crop parameters again is that as I work up an image I save interim working copies.  If 

one of my changes turns out to be a mistake, I can go back to a previous version and recover 

information from it to correct my mistake.  If the image size, etc. have not been changed, one image can 

simply be copied and pasted onto another.  They will be completely aligned layers then that are like the 

duplicate layers discussed below.  This makes it very easy to transfer information from one layer to 

another. 

 

For those not familiar with Photoshop, a very basic tool that is used constantly is the PS equivalent of 

άǳƴŘƻΦέ  ¢Ƙƛǎ ƛǎ άEdit>Step Backward.έ   !ōƻǾŜ ƛǘ ƛǎ ά{ǘŜǇ CƻǊǿŀǊŘΦέ  ²ƛǘƘ ǘƘŜǎŜ н ǘƻƻƭǎ ȅƻǳ Ŏŀƴ Ǝƻ ōŀŎƪ 

and forth to be sure the effect you just applied is a good one, or not. 
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 2. Duplicate Layers  

Because most tools and effects are best used selectively, I often make a duplicate layer to work on. 

(Layer>Duplicate Layer) 

 

The effects are then applied to the lower layer.  This might involve sharpening, softening, curves, or any 

number of other effects. 

Once the effect has been applied to the lower layer, the top layer is made the active one and the effects 

ƻƴ ǘƘŜ ƭƻǿŜǊ ŘǳǇƭƛŎŀǘŜ ƭŀȅŜǊ ŀǊŜ ŀǇǇƭƛŜŘ ŎƻƳǇƭŜǘŜƭȅ ƻǊ ƛƴŎǊŜƳŜƴǘŀƭƭȅ ƛƴ ǎƳŀƭƭ ǎǘŜǇǎ Ǿƛŀ ǘƘŜ ά9ǊŀǎŜǊέ 

brush.  ¢Ƙƛǎ άŜǊŀǎŜǎέ ǘƘŜ ǘƻǇΣ ŀŎǘƛǾŜ ƭŀȅŜǊ ŀƴŘ ŜȄǇƻǎŜǎ ǘƘŜ ƭŀȅŜǊ ǿƛǘƘ ǘƘŜ change. 

 

²ƘŜƴ ŘƻƴŜ ǘƘŜ ƛƳŀƎŜ ƛǎ άŦƭŀǘǘŜƴŜŘέ ό[ŀȅŜǊҔCƭŀǘǘŜƴ LƳŀƎŜύ ŀƴŘ ǘƘŜ ƛƳŀƎŜ ƛǎ ǎŀǾŜŘ as a working copy.  I 

ǎŀǾŜ άǿƻǊƪƛƴƎέ copies of the image after major changes just in case I want to go back. 

 3. Dust & Scratches 

One of the fastest ways ǘƻ ŎƭŜŀƴ ǳǇ ŀƴ ƻƭŘ ǇƘƻǘƻ ƛǎ ǘƻ ŀǇǇƭȅ ŀ t{ ŦƛƭǘŜǊ ŎŀƭƭŜŘ ά5ǳǎǘ ŀƴŘ {ŎǊŀǘŎƘŜǎΦέ 

(Filters>Noise>Dust & Scratches) 



9 
 

 

.ȅ ǎŜǘǘƛƴƎ ǘƘŜ άǊŀŘƛǳǎέ ŘƛŦŦŜǊŜƴt sizes of defects are removed.  I start at a radius of one on a duplicate 

layer and often apply that change to much of the final image.  Then I apply a larger radius Dust & 

Scratches and apply that to only the large defect, often in the shadows or plain skies.  

 4. Healing Brush  

If there is a defect in a plain area or one where people are not going to notice a slight inconsistency, the 

άIŜŀƭƛƴƎ .ǊǳǎƘέ ŘƻŜǎ ŀ ǊŜŀǎƻƴŀōƭȅ ƎƻƻŘ Ƨƻō ƻŦ ǇǳƭƭƛƴƎ ƛƴŦƻǊƳŀǘƛƻƴ ŦǊƻƳ ŀŘƧŀŎŜƴǘ ŀǊŜŀǎ ŀƴŘ ǊŜǘƻǳŎƘƛƴƎ 

the defect out of existence.  However, it is a dumb tool that applies its algorithm or program formula 

with no understanding of what the effects might be.  So, it has to be used carefully if next to an edge or 

details. 
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 5. Clone/Rubber Stamp Tool 

One of the most useful if slower tools is the clone tool.   

 

With this tool one can much more intelligently replace a defect in the image with what common sense 

tells us was under the defect.  Even if the peak of a building has been chopped off by the original 

photographer, we can use the clone tool to reconstruct the image.  Faces can also be reconstructed if 

ǘƘŜȅΩǾe been damaged.  This is, in effect, painting with the textures, values and colors that are in the 

ƛƳŀƎŜ ƛƴ ŀŘƧŀŎŜƴǘ ŀǊŜŀǎ ǎƻ ǘƘŀǘ ǘƘŜȅΩƭƭ ƳŀǘŎƘΦ  LǘΩǎ ƻƴŜ ƻŦ ǘƘŜ Ƴƻǎǘ ǇƻǿŜǊŦǳƭ ǘƻƻƭǎ tƘƻǘƻǎƘƻǇ ŎƻƴǘŀƛƴǎΦ 

 6. Content Aware Fill  

If a large area of a plain sky, or area like dirt with detail that is mostly a random pattern, is missing, a 

larger version of the healing brush is the Content Aware Fill tool.  (Edit>Fill>Content Aware)  For 

example, if an area of sky is missing, first select that area ǿƛǘƘ ǘƘŜ άtƻƭȅƎƻƴŀƭ [ŀǎǎƻ ¢ƻƻƭέ ƛƴ ǘƘŜ ƭŜŦǘ 

hand tool box of Photoshop.  Then άFƛƭƭέ the selected area using the ά/ƻƴǘŜƴǘ !wareέ option.   The 

program pulls from adjacent areas and does a reasonable job of taking care of the missing information.  

Many images need to be rotated to straighten horizons.  Replacing missing edges where they were sky 

ƻǊ ŘƛǊǘ ƛǎ ǊŀǘƘŜǊ Ŝŀǎȅ ǿƛǘƘ ǘƘƛǎ ǘƻƻƭΣ ǿƘƛŎƘ ƛǎ ƻƴŜ ƻŦ !ŘƻōŜΩǎ ƭŀǘŜǎǘ ŎǊŜŀǘƛƻƴǎΦ 

 


